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Introduction 
Welcome to the Right Hemisphere® Getting Started Guide. 

This manual is a quick start guide for the Right Hemisphere products: 

 Deep Exploration™ 

 Deep View™ 

 Deep Paint 3D® 

 Deep UV™ 

It contains the information you will need to install and begin using each application. 

After installing and starting your product, you can continue to learn about it with the assistance of the 
application's User Reference, accessed from the product menu or by pressing F1. 
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Assumptions 

Certain assumptions have been made regarding the use of the product: 

 You should be familiar in the use of the Microsoft Windows interface. 

 You should be familiar with 3D concepts. 

 You should be familiar in the use of your 2D painting applications if you wish to use any 2D 
application plugins. For example, Adobe Photoshop. 

Note: This is for users of 2D software applications only. 

 You should be familiar in the use of your 3D modelling applications if you wish to use any 3D 
application plugins. For example, 3ds max. 

Note: This is for users of 3D software applications only. 

 You should be familiar in the use of Word, PowerPoint, Excel, and FrameMaker if you want to use 
these applications with Deep View (http://righthemisphere.com/products/dv). 
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Documentation 

The following documentation is included with Right Hemisphere products: 

Getting Started Guide 

A guide to getting started for all Right Hemisphere applications and modules. 

User Reference 

In the form of online Help, this reference contains detailed information about all the features and capabilities 
of the application. It is organized mainly by functional areas. Note that there may be more than one reference 
available depending on the application you are using. 

Quick Reference Card 

A list of the keyboard shortcuts may be provided depending on the product you have purchased. 

Note: Only the online Help is available if you downloaded your product from the Internet. 
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Documentation Conventions 

Certain conventions are used within the documentation to make it easier to use: 

 Commands, tools, and selections are displayed in bold typeface. For example, click OK. 

 Menu and submenu commands are separated by the greater-than (>) sign. For example, File > 
Open. 

 Specific keystrokes are represented in capitals. For example, DELETE. 

 Instructions are displayed as numbered steps. 

 Related section headings are displayed in italic typeface if the section is within the current Help 
topic. 

 Related section headings are linked (underlined), to the appropriate section if it is located in another 
Help topic. 

 Where the word 'the application' is mentioned, the content relates to the application that you are 
using. 

 Where the word 'image' is mentioned, the content relates specifically to a 2D representation. 

 Where the word 'scene', 'model', or 'object' is mentioned, the content relates specifically to a 3D 
representation. 

 Where words are displayed within square brackets [ ], substitute the relevant text for the described 
action. 

 Where the plus (+) and minus (-) keys are mentioned, they relate to the number pad and not the 
QWERTY section of the keyboard. 

 Where modules are mentioned, the term refers to products for which modules may be purchased. 
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Support 

Online 
Our online support page contains technical support information relating to all of the Right Hemisphere 
products. It provides access to the latest patch releases, tutorials, links to the registration pages, and the 
Right Hemisphere Forum including newsletters, FAQs, and tips and tricks. 

Please take the time to check the support page 
(http://www.righthemisphere.com/support/contact_support.php) if you have any queries before sending us 
an email, in particular, you should check the Knowledgebase http://www.righthemisphere.com/support/kb/. It 
is most likely that the answer is right there! 

Registration and Activation 
If you require assistance with registration or activation, please contact us using our support form 
(http://www.righthemisphere.com/support/contact_support.php). 

Help 
The application User Reference is accessed from the product menu and, depending on the product you are 
using, by pressing F1. It contains detailed information about all the product features and capabilities and 
includes guides to the program controls. 
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Secure Online Ordering 

Right Hemisphere products can be purchased through re-sellers or from the Right Hemisphere Store 
(http://www.righthemisphere.com/store/). 

Our Secure Online Ordering services ensure that your confidential information remains confidential. Products 
delivered via our Web site (http://www.righthemisphere.com) are processed as soon as your payment is 
received, while orders for boxed products are usually processed within one business day. 

With your Right Hemisphere product, you receive a Serial Number/Order ID used to register and activate the 
product. For download sales, this is sent via email. 

If you make a payment but do not receive confirmation with your Serial Number/Order ID within a reasonable 
amount of time (two business days for credit card payments or two weeks for other payments), please 
contact us (http://www.righthemisphere.com/support/contact_support.php). 

For information on multiple pricing (five or more licenses), purchase orders, wire transfers and educational 
discounts, please contact us (http://www.righthemisphere.com/support/contact_support.php). 
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Installation 

Installing Products using Electronic Software Delivery 

Procedure 

To install the software from electronic software delivery: 

1. Go to the Right Hemisphere product download page 
(http://www.righthemisphere.com/support/downloads/download.php). 

2. Enter your details and select the check boxes for the products you want to download, and then click 
Submit. You will receive a support email detailing the product serial numbers. 

3. In the support email, click the link located below the product serial number. The product download page 
is displayed. 

4. Click Download. 

5. Do one of the following: 

 Click Save, navigate to and select a location to save the file, and then click OK. 

 Click Run to install the file automatically once it is downloaded. 
 

6. If you saved the file, double-click the saved file. You are then guided through the product's installation. 

7. Repeat steps 4 through 7 for each product. 

8. Register and activate (on page 12) the product. 
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Installing Products from CD-ROM 

To install the software from CD-ROM: 

1. Close all applications and insert the CD-ROM into the CD-ROM drive. The Right Hemisphere Product 
Suite dialog is displayed. 

2. Select the check boxes for the products you want to install. 

Note 1: To install a Deep Exploration module, you must have the current version of Deep Exploration installed. 

3. Click Install. The installation begins. 

4. Follow the instructions as they appear on your screen, making sure you accept the Right Hemisphere 
License Agreement, and then click Finish. 

5. If you selected to install more than one product, complete step 4 for each installation. 

Note: Each product installation begins automatically after the previous installation has completed. 

6. Register and activate (on page 12) the products. 

Note 1: If you are installing Deep Paint 3D or Deep UV, ensure the font setting is set to the default size in the 
Windows Control Panel. This ensures the screen displays correctly. 

Note 2: If you choose to begin using the application without registration or activation, the 30-day trial period begins. 
When the trial period expires, you must register and activate the program to continue using the application. 

Installation Deep Exploration 
Deep Exploration can be installed directly from the CD-ROM, or it can be downloaded and installed from the 
Right Hemisphere Web site. After installation, you can install any purchased modules. 

You must have administrator privileges to install this software. 

Once the installation is complete, registration and activation (on page 12) should be completed before using 
the program. You can also choose to begin using the program without registration or activation, in which 
case the 30-day trial period begins. When the trial period expires, you must register and activate the program 
to continue to use it. 

Procedures 

To install Deep Exploration from the CD-ROM: 

1. Insert the CD-ROM into the CD-ROM drive. 

2. Use Windows Explorer to locate the Setup.exe file. 

3. Double-click the Setup.exe file to start the installation. 

4. Follow the instructions as they appear on your screen. 

You can now register and activate Deep Exploration. 

To install the modules from the CD-ROM: 

1. Insert the CD-ROM into the CD-ROM drive. 

2. Use Windows Explorer to locate the Setup.exe file for the module you want to install. 

3. Double-click the Setup.exe file to start the installation. 

4. Follow the instructions as they appear on your screen. 

You can now register and activate the module. 
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Registration and Activation 
After installation, products should be registered. After registration, all product licenses must then be 
activated. Registered users receive information about the latest version of the application via email. Any 
problems that might arise are given priority by our technical team. 

Registered users also receive a user name and password with which to access the Updates Section of the 
Right Hemisphere Web site. This page contains product updates and the latest plugin and patch downloads. 

Note: You are not sent a user name or password for Deep View. This product does not require registration or activation. 

This section describes how to register and activate the Right Hemisphere applications and modules 
described within this guide. 

If you require assistance with registration or activation, please contact us using our support form 
(http://www.righthemisphere.com/support/contact_support.php). 

Note: If you have purchased multiple copies/licenses, you will need to repeat registration and activation for each product 
Serial Number/Order ID you own. 

Before registering your product, ensure you have an active Internet connection. 
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Product Registration 

Before registering your product or any purchased modules, ensure you have an active Internet connection. If 
not, you can register the product offline. 

Procedures 

To register the application or a module online: 

1. Go to the Right Hemisphere registration page (http://www.righthemisphere.com/support/register/). 

2. Select the product you want to register. 

3. Enter the Serial Number/Order ID, as sent to you with your product purchase, in the Serial Number/Order 
ID field and click Next. 

4. Enter the required information in the appropriate fields ensuring all mandatory fields (*) are complete. 

5. Click Next. 

Registration is now complete. If you are registering an application, a Product Authorization Code, user name 
and password are sent to you via email, and you can now activate the product license. If you are 
registering a module, you are sent a user name and password via email. 

To register the application or a module offline: 

Contact support using our support form (http://www.righthemisphere.com/support/contact_support.php). 
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License Activation 

After product registration, you must activate the product from within the application itself.  
 

Deep Exploration 
After product registration, you must activate the product license. 

The network license pack allows a floating license system. This means that you can purchase a number of 
licenses, and have the usage of these licenses managed centrally on one License Server computer. 
Company installation is then made much easier, as it means that each user does not need to individually 
license Deep Exploration. 

The standalone fixed license has two options for activation. These are: 

 Internet activation, which allows you to license Deep Exploration on your computer for a period of 
time or forever. 

 Manual activation, which enables single users who do not have access to the internet to be 
authorized by email, and then manually entering the authorization key. You can also extend the trial 
period of your product in this way. 

Procedure 

To activate Deep Exploration: 

1. Click the Windows Start button, choose All Programs > Right Hemisphere > Deep 
Exploration 5 then click Deep Exploration. 

2. Choose Help > Activate Deep Exploration on the menu bar. 

3. Enter the required information. 

4. Click OK and restart Deep Exploration. 

Activation is now complete. 

Interface 

Standalone Fixed License—Used to activate the application for standalone licensing. That is, single 
user licenses. 

 Activation Code—The activation code provided by Right Hemisphere. This is a 16 digit code 
issued by Right Hemisphere. 

 Automatic via Internet—Used to activate your license via the internet. 

o Automatic—Click to automatically activate the license. No further action is required. 

 E-mail Activation—Used to activate the license via email. This method should be used when 
you do not have access to the internet. Your activation code is sent via email to Right Hemisphere 
support. Your license code is returned, also via email, and should be manually entered in the field 
below. 

o Send E-mail—Click to send the activation code details via email. 

 Enter License—Used for manual entry of the license code. 

 License for—Used to select whether the application is available to one user only, or all users on 
this computer. 

o Current User—The application is available only to the user activating the product. 

o All Users—The application is available to all users on this computer. 

Network Fixed or Floating License—Used to enter network options for licensing. 
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 Server Name or IP Address—The host name/IP address. 

 Port Number—Provided by your system administrator. 

 Standard Edition—Denotes a Deep Exploration Standard Edition license. 

 CAD Edition—Denotes a Deep Exploration CAD Edition license. 

 Test Connection—Tests the network connection that you have entered. 

 Use Backup Server Settings—Used to nominate a backup server that would be used in the 
event of the production server failing. 

o Backup Server Name or IP Address—The host name/IP address. 

o Port Number—Provided by your system administrator. 

Legacy License Activation for DE 5.0 Customers—Options to activate the application for existing 
customers. 

 Serial Number—The serial number of the application. 

 Authorization Code—The authorization code. 

 License for—Used to select whether the application is available to one user only, or all users on 
this computer. 

o Current User—The application is available only to the user activating the product. 

o All Users—The application is available to all users on this computer. 

OK—Applies and saves the settings, and then closes the dialog. 

Cancel—Closes the dialog. Any changes made to the settings are lost. 

Help—Opens the relevant Help topic. 
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Deep Paint 3D and Deep UV 

Procedure 

To activate Deep Paint 3D and Deep UV: 

1. Click the Windows Start button, choose All Programs > Right Hemisphere > Deep Paint 
3D then click Deep Paint 3D. 

2. Do one of the following: 

If you are activating Deep Paint 3D, choose Help > Activate Deep Paint 3D on the menu bar. 

3. Enter your Serial Number/Order ID and Authorization Code in the appropriate fields. 

4. Do one of the following: 

 Click Current user only to make the application available only to the user activating the product. 

 Click All users to make the application available to all users on this computer. 

Note: Administration rights are required to activate the application using this option. 

5. Click Activate and restart Deep Paint 3D. 

Activation is now complete. 
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Trial Period 

For all applications except Deep View, a 30-day trial period is available during which most functionality is 
enabled. The trial period begins automatically. 

At any time during this trial period, you can register and activate the product license, or you can wait until the 
trial period is complete. Both your Serial Number/Order ID and Product Authorization Code (on page 12) 
establish the license type. 

When the trial period expires, certain functionality is disabled, the application cannot be started, or content 
you create includes watermarks, again depending on the application. You must now complete registration 
and activation (on page 12) to license the product. 

Deep Exploration 
Deep Exploration is sold in two forms: the CAD Edition and the Standard Edition. After installation of either 
product, a 30-day trial period begins during which full functionality is available including: 

Opening standard and CAD supported file types. 

Saving to standard and CAD supported file types. 

Full CADTools, Illustration, Realight, and UV Mapping functionality. 

Full error reporting. 

Trial Period Expiry 

Please note that when the trial period expires: 

3D models are view only; all exporting capabilities are disabled including rendering to file, raytrace 
rendering, and batch conversion. 

CAD file load functionality is disabled. 

The CADTools and Illustration toolbars are disabled in Deep Exploration CAD Edition. 

Deep Paint 3D 
Deep Paint 3D is fully functional during the trial period. However, when you try to start the application after 
the trial period expires, you are required to complete registration and activation. 

Deep UV 
Deep UV is fully functional during the trial period. However, when you try to start the application after the trial 
period expires, you are required to complete registration and activation. 
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Updating 

The update procedure differs depending on the product you want to update: 

Manual and automatic updates via the individual application's Help menu. This method uses Right 
Hemisphere's Cortex utility 
(http://www.righthemisphere.com/support/help/cortex/cortex_readme.htm), which is installed by 
default when the application is installed. 

Manual updates from within the Cortex utility. 

Manual updates via the Patches section 
(http://www.righthemisphere.com/support/register/all_reg2.php?ara=1) of the Right Hemisphere 
Web site. This method should be used if you do not have an Internet connection. 

Please see the individual product Help references for further information. 
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Starting an Application 
Deep Exploration, Deep View, Deep Paint 3D, and Deep UV can all be started either from the Windows Start 
menu, your desktop or Windows Explorer. Deep View Complete can be started from within Word, 
PowerPoint, Excel, or FrameMaker. 
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Deep Exploration, Deep View, Deep Paint 3D, and Deep UV 

To start Deep Exploration, Deep View, Deep Paint 3D, or Deep UV, do one of the 
following: 

Click the Windows Start button, choose All Programs > Right Hemisphere > 
[application], and then click the application name. 

Double-click the application icon on your desktop. 

The application interface is displayed and you can begin using the program. See the sections Deep 
Exploration, Deep View, Deep Paint 3D, and Deep UV. 

Note: You can also start the applications from Windows Explorer by double-clicking the relevant [application].exe file 
within the default installation folder. For example, C:\Program Files\Right Hemisphere\Deep Exploration. 

 
 

Deep View Complete 

To start Deep View: 
Open a new or existing PowerPoint presentation, Word document, FrameMaker document, or Excel 
spreadsheet. 

If you installed Deep View Complete, the Deep View menu is displayed in Office applications.  

If you installed Deep View, you can now view 3D content. Click the Windows Start button, choose All 
Programs > Right Hemisphere > Deep View 5 then click Deep View. 
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Applications 

Deep Exploration 

Overview 
Deep Exploration is a desktop application with a Windows Explorer-like interface used to manage 2D, 3D, 
animation, video and audio files residing on a computer or network. 

It enables you to quickly translate and convert graphics, create high-quality renderings of 3D objects and 
scenes for use in other graphic applications. An SDK is available to create custom graphics, management 
and manipulation tools. 

Key Features 
Rapid import process. 

3D objects and materials browse capability. 

3D model and texture Web search. 

File history browse facility. 

Effortless organization of 3D models. 

Display and hide separate objects. 

Multiple viewports. 

Gradient and image background, and shadow display. 

Object position controls. 

Slide show creation. 

Thumbnail generation. 

Built-in export features. 

Batch processing. 

Creation of user-defined views based on the current scene view. 

Easy management of plugins, registration, and licensing. 

Full-screen display mode with auto-hide toolbars. 

Export to Adobe PDF documents. 

Layers are utilized to group scene objects into a single hierarchy level. 

Background images can be added to scenes. 

Distance measurements between elements or within a single element. 

Creation of preset 3D objects (primitives) including spheres, stairs, gears, and archways. 

Ability to alter 3D objects while keeping file sizes to a minimum. 

Object instancing. 

Advanced material display. 

Steps and Procedures for manufacturing instructions. 

Technical Illustration workflow. 

Model Views can be grouped into 'Portfolios. Multiple Portfolios are supported. 

Alignment tools to easily align, distribute and center 2D objects. 

Camera alignment to point/face/surface. 

Support for "Y Up" or "Z Up" 3D coordinate systems. 
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Ability to highlight the children of a selected parent. 

Materials, Animation, Layers, Parts panes can be moved and docked from Scene Tree pane. 

 
 

System Requirements 
You must have the following software and hardware installed on the computer for Deep Exploration to 
function correctly. 

Minimum 
 Windows XP SP3 operating system. 

 Pentium 4 1Ghz processor or higher. 

 512MB of RAM (more for large model and texture sizes). 

 Microsoft DirectX, version 9. 

 Internet Explorer 6.0. 

 Graphics card capable of displaying 24-bit color. 

 3D hardware accelerator video card. 

Recommended 
 Windows 7 operating system. 

 Pentium 4, 2Ghz processor or higher. 

 3GB of RAM (more for large model and texture sizes). 

 Microsoft DirectX, version 9. 

 3D hardware accelerator video card with 256MB of RAM (OpenGL 2.0 and Shader Model 3.0 
support for HDR Rendering). 

Additional 
 To create custom PDF Templates using the included PDF Template Designer requires one of the 

following versions of Adobe®: 

o Acrobat®: Acrobat 8.1+ Pro, Acrobat 3D v8.1+, Acrobat 9 Pro or Acrobat 9 Pro Extended. 

 An Internet connection is required for 3D Web searches and Cortex updates. 

 To view and save 3ds Max files, a copy of 3ds Max must be installed. 

 To view and save Maya files, a copy of Maya must be installed. 

 To view Inventor 2010 files, Autodesk Inventor 2010 Viewer must be installed. 

 To view 3D content in a HTML Document with 3D (.html) files, Deep View must be installed. 

 The .rh file type must be added to the Microsoft Windows Server 2003 “recognize file type” set. 
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User Interface 
The software's user interface provides multiple ways to achieve the same goals. It consists of a number of 
components including the menu bar, the File and Folder Explorer, Panels (including custom panels), File 
lists, Status bar, and Animation controls. There are also a number of different toolbars, a viewport, and 
various right-click menus. 

 The toolbars contain many of the controls that you can use to change the display and properties of a 
model. 

 The Workspace contains the “viewports” that you use to view and modify a 3D model. Each viewport 
is a viewing area that lets you see the model from a different angle. 

 The File and Folder Explorer displays your files and folders in a tree structure, letting you easily find 
and open your working files from within the application. 

 The various panels provide a list of all the objects contained in a model, their parts, layers, and 
associated materials. You can use the Scene components panel to locate and select multiple objects 
at one time. You can also select the objects in a model by clicking them. 

All components can be resized, moved, floated, docked, rearranged, and closed similar to the functionality in 
most Windows applications. For example, you can resize the File and Folder Explorer by dragging the bar's 
edges, and you can drag files and folders within the Folders panel. Components are displayed as docked by 
default, and have a Windows-type interface. Some panels 'snap' together, and produce a tabbed display for 
easy access. For example, the Parts panel, Scene Components panel and the Layers panel are grouped 
together in the illustration below. These can also be individually floated. 

See the topics referenced below for detailed information on all of the user interface components. 

 
A: Application title bar 
B: Menu bar, and viewing tabs 
C: Toolbars 
D: File and Folder Explorer 
E: Scene/Parts/Layers Panels 
F: Workspace 
G: Steps and Procedures Panel 
H: File/Materials/Shaders lists 
I: Animation controls 
J: Status bar 
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Interface 

Application title bar—The current file name, path, and protection status. 

Menu bar, Layout Manager and viewing tabs—Provides access to the main menu commands, 
and also to the custom viewing tabs. 

Toolbars—Sets of buttons for commands relating to standard and additional functionality. These toolbars 
can be grouped together and added to custom viewing tabs. 

File and Folder Explorer—Used to display the Folders panel, the Favorites and History lists, the 
Search panel, and the File list tabs. 

Information bar—Displays various file, object, and material information relating to the current file 
depending on the viewport selection. 

Panels—Comprises a number of components including the Scene and Animation trees, the Materials list, 
and the Parts and Layers panels. It presents, and is used to control all of the scene’s 3D objects, materials, 
parts, animation, and layers from within a tree-view hierarchy. The Animation, Material, Layers and Parts 
panels can be launched separately, and are dockable. In addition, there are custom panels that give you 
added functionality for managing and modifying files and file display. 

Workspace—Comprises one or more viewports used to view and modify the currently opened file. For 
example, a 3D scene or 2D image. 

File lists—Displays all files and folders contained within the current folder, all files that match the search 
criteria after performing a search, all files contained within the 'My 3D Models' folder, and all the available 
material, texture, symbol, and shader files. It can be used to perform a number of functions including 
establishing file properties, refining searches, dragging textures, symbols, and shaders onto models, and 
generating thumbnails. 

Status bar—Displays various information relating to the current file and display renderer. 

Animation controls—Provides controls for animated scenes. 

Right-click menus—Sets of commands relating to the standard functionality. 
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Plugin Manager 
The Plugin Manager is a utility that lists the following information: 

 Plugins. 

 Plugin versions. 

 Import and export settings, where appropriate. 

 Plugin conflicts. 

It is used to view current plugins and files, establish import and export settings, and resolve plugin conflicts. 

Plugin conflicts are highlighted in orange on the File Formats tab. 

Plugin Tab 

The Plugins tab displays the plugin name, version, description, status, size, the supported import and export 
formats, and the plugin extensions. 

When Acrobat 3D Toolkit starts for the first time, the status of each plugin is listed as 'loaded' and a system 
file is created that informs Acrobat 3D Toolkit which plugins are used. Whenever the application is started 
again, this file is used to reference the plugins that are used so that the application opens without delay, and 
the status of each existing plugin is listed as 'defer'. 

From this point, only new plugins and the plugins that you select to view in the application are listed as 
loaded indicating that: 

1. New plugins have yet to be added to the system file for future reference. 

2. The plugins selected for viewing have been loaded into the application. 

File Format Tab 

The File Format tab displays a list of formats with various information including the format name, extension, 
type, whether files are import and export in nature, and their related plugin. 

The tab is used to resolve any plugin or format conflicts (highlighted in orange), and modify and restore the 
default import and export properties. You can also move the format rows up and down within the list to view 
any plugin or format conflicts more easily. 

Most file extension conflicts are resolved automatically; if one plugin cannot load a file with the supported file 
extension, the other plugin tries to load the file. 

 
 

Copyright © Right Hemisphere 2009. All Rights Reserved. 



26 Getting Started Guide   Applications 

Deep View Complete 

Overview 
Deep View Complete is an authoring tool that enables you to insert 3D models into Adobe FrameMaker 
documents, and Microsoft PowerPoint presentations, Word documents, and Excel spreadsheets. You can 
also convert 3D content into PDF document format, and view 3D content within Right Hemisphere HTML 
documents created using Deep Exploration. 

Complex engineering and animation data can be used for sales presentations, training material, technical 
documentation and online catalogues. 

Key Features 
Microsoft Office integration: Excel, PowerPoint and Word. 

Adobe FrameMaker integration. 

Drag and drop: Used to insert files into PowerPoint and Word documents. 

Linking and embedding: Files can be linked, embedded or a combination of both in PowerPoint, 
Word, and FrameMaker. 

Resizing and moving images and models. 

Rotate, pan and zoom: Available for 3D models. 

Converting files to 3D PDF 

Animation toolbar: Used to control model animation and includes a frame slider, a locking button 
and animation options. 

Adding markups to images and scenes. 

Adding measurements to scenes. 

Viewing steps and model views. 

Scene settings: Available for 3D model manipulation including outlines, smoothing, lights and 
graphics display mode. 

Transparency: Hide and show parts or add transparency to 3D presentations. 

Display Renderer 

When you first insert a file into a document, the Default Rendering Mode dialog displays a list of the available 
display renderers for the graphics card that is installed on your computer. The display renderer determines 
how scenes are rendered while you work, and the best renderer for your graphics card is automatically 
detected as the default. 

We recommend using the default renderer. However, you can modify it at a later date if required. 
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System Requirements 
You must have the following software and hardware installed on the computer for the application to function 
correctly. 

Note: This application is certified for Office XP (2002), Office 2003, and Office 2007. 

Minimum 
 Windows XP SP3 operating system. 

 Pentium III 266 processor. 

 128MB of RAM (more for large model and texture sizes). 

 Graphics card, with the latest drivers, capable of displaying 24-bit color. 

Recommended 
 Windows XP SP3 operating system. 

 Pentium III 733 processor or higher. 

 256MB of RAM (more for large model and texture sizes). 

 Graphics card with the latest drivers,128MB of RAM, and support for DirectX or OpenGL. 

Additional Requirements 
 Publishing to PDF. 

o Adobe Acrobat version 7.0.9 or higher. 

 Publishing to Office Documents. 

o Microsoft Office for Windows XP or Office 2003 or higher if you are using the application with Office 
applications. 

 HTML Viewing. 

o Internet Explorer 6 or later. 

 Visual Compare. 

o Graphics Card which supports Direct X 9 and Shader Model 2. 

 HDR Rendering. 

o Graphics Card which supports OpenGL 2.0 and Shader Model 3.0. 
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User Interface 
The application interface in Office applications consists of the Deep View menu. In FrameMaker, these 
commands are accessed via the right-click menu. Certain other interface elements and tools become 
available once 3D content is created. 

See the topics referenced below for detailed information on all of the user interface components. 

Interface 

Deep View menu—Provides access to the main Deep View menu commands. 

Viewports—Comprises one of two viewports that are used to view and modify the currently opened file. 
For example, a 3D scene or 2D image. The viewport type depends on the current Deep View mode: 

 Image mode: Displays 2D content in the 2D viewport. 

 Interactive mode: Displays 3D content in the 3D viewport. 

Information panel—Displays various types of information relating to the current file, depending on the 
viewport selection. The available components of the Information Panel vary, depending on the contents of 
the 3D file. For example, if a file does not contain steps or model views, these components do not display. 

 Scene Tree—Comprises the the 3D Objects list, Model Views, and Steps. 

 Parts—Displays a list of all parts associated with a model. 

 Layers—Displays all layers associated with a model. 

 Model Views—Displays all model views associated with a model. 

 Steps—Displays all steps associated with a model. 

 Collaboration—Displays the Collaboration window, and enables you to start conversations and 
collaborate with others. 

Note: If you are accessing Deep Exploration via Deep Access 5.7.x or earlier, the Collaboration Window is not 
available. Original teamwork markups using the Drawing and Markup toolbar only are available. 

Measurement toolbar—Used to display the Measurement control tools. 

3D Editor toolbar—Used to display various view modes, clipping and pull apart tools. 

2D Editor toolbar—Used to display buttons relating to functionality for 2D images. 

Note: The 2D Editor toolbar is only available when viewing 2D images. 

3D PDF toolbar—Used to convert 3D content to 3D PDF. 

Note: The toolbars Fade effect will be automatically turned off when you switch to the OpenGL renderer. 

Right-click menus—Sets of commands relating to the standard Deep Exploration functionality. 
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Working Modes and Inserting Files 
Two modes are used to work with 2D images and 3D models once a file is inserted into a document: 

 Image mode: Presents a 2D representation which can be moved and resized using controls. The 
Information bar and other toolbars are not displayed in Image mode. 

Note: You cannot move images in Word documents. 

 Interactive mode: Presents a 3D representation which can be rotated, panned, scaled, or 
zoomed. The 3D viewport menu, Teamwork toolbar, Information bar, and Animation toolbar, can be 
used to control scene settings, objects, materials, and animation. 

The mode in which files are inserted depend on the application in use; these are called the 'working modes'. 
When documents are reopened, the files are displayed in a working mode particular to the current 
application, regardless of how the document was last saved. You can switch between the modes as 
required.  

Note: PowerPoint presentations are always displayed in Interactive mode. 

Working Modes 

Application Inserting Content Opening Files 

PowerPoint normal view Image Image 

PowerPoint slide show view Interactive Interactive 

Word Image Interactive 

FrameMaker Interactive Image 

Excel Interactive Interactive 
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Deep View Minimum 

Overview 
Deep View Minimum is a viewing tool that enables you to view content created with Deep View Complete. It 
has no interface and if installed on your computer, the application starts automatically whenever you view 3D 
content created using Deep View Complete. 

Key Features 
Microsoft Office integration: Excel, PowerPoint and Word integration. 

Adobe FrameMaker integration. 

Rotate, pan and zoom: Available for 3D models. 

Animation toolbar: Used to control model animation and includes a frame slider, a locking button 
and animation options. 

Scene settings: Available for 3D model manipulation including outlines, smoothing, lights and 
graphics display mode. 

Transparency: Hide and show parts or add transparency to 3D presentations. 
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System Requirements 
You must have the following software and hardware installed on the computer for the application to function 
correctly. 

Note: This application is certified for Office XP (2002), Office 2003, and Office 2007. 

Minimum 
 Windows XP SP2 operating system. 

 Pentium III 266 processor. 

 128MB of RAM (more for large model and texture sizes). 

 Graphics card, with the latest drivers, capable of displaying 24-bit color. 

Recommended 
 Windows XP SP2 operating system. 

 Pentium III 733 processor or higher. 

 256MB of RAM (more for large model and texture sizes). 

 Graphics card with the latest drivers,128MB of RAM, and support for DirectX or OpenGL. 

Additional Requirements 
 Publishing to PDF. 

o Adobe Acrobat version 7.0.9 or higher. 

 Publishing to Office Documents. 

o Microsoft Office for Windows XP or Office 2003 or higher if you are using the application with Office 
applications. 

 HTML Viewing. 

o Internet Explorer 6 or later. 

 Visual Compare. 

o Graphics Card which supports Direct X 9 and Shader Model 2. 

 HDR Rendering. 

o Graphics Card which supports OpenGL 2.0 and Shader Model 3.0. 
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Deep Paint 3D 

Overview 
Deep Paint 3D is a real-time materials-based 3D painting system. While Deep Paint 3D can be used as a 
stand-alone program to paint pre-existing objects or to create 2½D images from a blank canvas, it is 
designed to integrate closely with your existing work-flow, passing images back and forth between your 3D 
application, Photoshop, and Deep UV. 

Key Features 
Brush cursor: Displays an outline of the current brush shape on the object or material. 

Stroke preview: Displays an example stroke of the selected brush and paint combination or 'preset'. 

Print preview: Only applies to 2½D mode and gives a preview of the image as it would appear 
printed. 

Pressure-sensitive digitizing tablet support: An electronic tablet and a cursor or pen that enables 
you to enter drawings and sketches into the computer that enable response to changes in pressure, 
pen angle, direction or speed of movement. 

Export to Photoshop: Allows you to save a material and all its layers as a PSD file as a more 
measured and robust way of communicating with Photoshop. 

Splines: Splines (curves) can be used to create selection masks to define the path of a brush stroke 
with more accuracy than by hand or to repeat the same brushstroke with different settings. 

Batch operations: Allows the application of operations across the selected materials such as adding 
and deleting layers, changing material properties and applying some filters making it easier to 
manage large numbers of materials. 

Lock paint layer: Used to specify the size of the projection for projecting images larger than the 
screen. 

Projection paint: Used to project a layer of paint onto an object so that unsightly scenes are 
eliminated. Projections can be saved, loaded and restored. 

Image stamp: Allows you to define a temporary image stamp by capturing a piece of the current 
material. The modify feature allows the user to change the image size, rotation, etc., interactively in 
the viewport. 

Save all maps: Used to customize the names of saved maps. 

Working with Photoshop 
Deep Paint 3D includes a companion plugin for Photoshop. Although Deep Paint 3D can be used 
stand-alone, it is designed to complement Photoshop by adding tools to Photoshop's powerful image 
processing capabilities. 

Materials can be passed between Deep Paint 3D and Photoshop. 

Uninterrupted work-flow. 

For a complete guide to Photoshop plugins, refer to the Photoshop documentation. 

Note: It may be possible to use the Deep Paint 3D plugin with other software that supports Photoshop plugins. 
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System Requirements 
You must have the following software and hardware installed on the computer for Deep Paint 3D to function 
correctly. 

Minimum 
 Windows 2000 operating system. 

 Pentium III 450 processor or better. 

 64MB of RAM (more for large model and texture sizes). 

 Internet Explorer 6.0. 

 Graphics card, with the latest drivers, capable of displaying 16-bit color. 

 Minimum resolution of 800x600 pixels. 

Note: Ensure the font setting is set to the default size in the Windows Control Panel. This ensures the screen 
displays correctly. 

Recommended 
 Windows XP operating system. 

 Pentium III 500 processor or better. 

 128MB of RAM (more for large model and texture sizes). 

 Graphics card capable of displaying 24-bit color. 

 Wacom Intuos or similar pressure-sensitive tablet. 
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User Interface 
The user interface provides multiple ways to achieve the same goals, and comprises a number of 
components including the menu bar, 2D canvas, 3D workspace, Tools palette, Tools Options palettes, and 
the Command Panel. There are also a number of additional palettes, different toolbars, and various 
right-click menus. 

The components and menu commands that are displayed depend on the mode in which you are in: 2D, 
2½D, or 3D mode. 

Many of the components can be resized, moved and closed similar to the functionality in most Windows 
applications. For example, you can resize the windows by dragging the windows' edges. All palettes, the 
Command Panel, the Projection Paint toolbar, and the Information toolbar can float in the workspace, and 
they can be docked, moved, and hidden. 

See the topics referenced below for detailed information on all of the user interface components. 

Interface 

Application title bar—Displays the current file name. 

Menu bar—Provides access to the main menu commands. 

File toolbar—Provides quick access to many of the tools of some of the most common tasks in Deep 
Paint 3D. 

Canvas—Used to edit all images and models. It is displayed with a white background by default and a 
black background when editing a 3D object. The background can be modified with another color or with an 
image. 

Workspace—The gray area surrounding your canvas in 2½D and 2D modes or areas of canvas not 
occupied by objects in 3D mode. It is used to open, and paint 3D files. 

Tools palette—Provides access to most common tools. 

Tools Options palette—Displays all the buttons and options that are available for the selected tool. 

Command Panel—Used to access most of the painting features that are grouped into four sub-panels. 
Certain sub-panels comprise various rollouts that can be expanded and contracted. 

Palettes—Provide access to the Tools, Color, Color Swatches, and Shapes palettes tools and options. 

Toolbars—Sets of buttons for commands relating to standard functionality. 

Right-click menus—Sets of commands relating to the standard functionality. 

 
 

Working Modes 
Deep Paint 3D operates in three distinct modes, 2D, 2½D, and 3D. 

2½D mode: Used to paint two-dimensional images with color, bump and shine rendered in real time. 

2D mode: Allows you to view and paint an 'unwrapped' bitmap of a single channel while painting a 3D 
model. 

3D mode: This mode is active whenever a 3D model is loaded into Deep Paint 3D and allows you to paint 
your model in three-dimensional space with real-time rendering of color, bump, shine, glow, and opacity. 
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Tablets 
Deep Paint 3D is greatly enhanced by pressure-sensitive digitizing tablets used in conjunction with certain 
features that respond to changes in pressure, pen angle, direction or speed of movement. Deep Paint 3D 
supports the use of WinTab compatible graphics tablets and styluses, including the Wacom Intuos airbrush 
and Intuos mouse. 

Note: the Wacom Intuos series of tablets has individually numbered pens. Deep Paint 3D remembers and returns to the 
last preset used with a given pen. 

Presets 
Presets are combinations of brush and paint settings that are stored for quick retrieval. New presets can be 
created and edited, default presets can be customized and they can all be saved and organized into defined 
categories. 

Deep Paint 3D Plugin 
When used as a plugin, the application with which Deep Paint 3D operates uses a significant amount of 
RAM. This RAM is not released when running Deep Paint 3D through the Plugin Manager. 

You can free-up RAM by running the program in stand-alone mode and loading your image or model file 
directly using the File > Open command. 

Working With Large Files 
Unlike traditional digital paint systems, Deep Paint 3D treats painting as a complete material application 
process. It renders in 3D by modelling the true material characteristics of paint, including viscosity, thickness, 
opacity and shine, with every stroke. 

Deep Paint 3D processes three to five times as much data as a traditional paint system. Consequently, it 
uses three to five times the RAM, and needs much more processing power than simpler programs; working 
with large images in Deep Paint 3D requires an appropriate amount of processing power and RAM. We 
recommend the following amounts of RAM to work effectively with large images. 

Image Size (pixels) Recommended RAM 

1500 x 1500 64MB 

2000 x 2000 128MB 

3000 x 3000 256MB 

4200 x 4200 512MB 

6000 x 6000 1GB 

 

Note 1: Figures are for stand-alone operation of Deep Paint 3D. When operating with another image-processing 
program, subtract 25% from each pixel value. 

Note 2: Pixels equal dots. Therefore, a 10" x 10" image at 150 dpi is 1500 x 1500 pixels and at 300 dpi, it is 3000x3000 
pixels. 

Due to the random nature of natural paint, it is often not possible to work effectively at pixel resolutions two 
to three times lower than the target output resolution. The image can be scaled up later to a higher resolution 
without noticeable loss of quality. 

We recommend re-scaling in Photoshop using the Image > Resize command or in Deep Paint 3D using the 
right-click menu command, Resize Image while in 2½D mode. The same applies to 3D texture maps. For 
example, a 1000 x 1000 image can be re-scaled to 2000 x 2000 in an acceptable state for final production, 
reducing the RAM requirements for editing in Deep Paint 3D. 
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Deep UV 

Overview 
Deep UV is a set of tools for the creation and modification of UV mapping for polygonal models within an 
interactive 2D and 3D UV mapping environment. It can be used as a standalone application, or with Deep 
Paint 3D. 

UV Mapping describes the relationship or 'projection' between a three-dimensional surface point (described 
by X, Y and Z values) and a two dimensional surface point described by U and V values. It is useful in 
describing the relationship between 2D texture maps and their position on a 3D model. 

Deep UV provides enhanced mapping productivity and assists in the creation of distortion-free UV mapping. 
It allows multiple mapping types to be combined on a single material for optimum bitmap usage and 
minimizing distortions and seams. 

Note: The font setting for your graphics card is set to the default size in the Windows Control Panel to ensure the screen 
displays correctly. 

Key Features 
Interactive texture UVs: Used to manipulate texture UV's interactively on 3D models. 

Real-time UV editing: You can easily see real-time UV editing updates in 2D and 3D. 

Untangle UVs: Untangle overlapping UV's instantly. 

Relax tools: Minimize distortions by selection. 

Soft selection and feather tools: Interactive 2D, 3D soft selection and feather tools. 

UV packing algorithms: Efficient algorithms pack faster and closer. 

Merge materials: You can create a single material without quality loss. 

Speed loading: Place all objects from a scene on a single bitmap to speed load. 

Plugins: Autodesk 3ds Max, Autodesk Maya, Softimage® XSI™ and Deep Paint 3D plugins have 
been added. 

Distortion free mapping: V.A.M.P creates distortion free mapping. 

Preserve textures: From one UV mapping to another and retain existing texture map information. 

Preview: Dynamically preview unwrapped UV coordinates while altering planar, cylindrical, and 
spherical mapping. 

UV map types: Apply UV map types to different object parts or materials. 

Soft selection: Move, scale, rotate, shear, and flip UV data with soft selection for precise control. 

Selection tools: Select UV points, polygons or groups in 2D or 3D with magic wand, lasso or 
rectangular selection tools. 

Advanced 3D selection: Select surface areas of objects by angle deflection from selected faces. 

Automatic mapping: For quick and easy mapping. 

Interactive mapping: Tools provide dynamic visual feedback on UV unwrapping of a material to 
obtain the best mapping for each type of shape. 

Auto unwrapping: For complex shapes outside a category. 

 
 

Copyright © Right Hemisphere 2009. All Rights Reserved. 



 Getting Started Guide    Applications 37 
 

System Requirements 
You must have the following software and hardware installed on the computer for Deep UV to function 
correctly. 

Minimum 
 Windows 2000 operating system. 

 Pentium 200-MMX processor or higher. 

 64MB of RAM (more for large model and texture sizes). 

 Internet Explorer 6.0. 

 Graphics card, with the latest drivers, capable of displaying 16-bit color. 

 Minimum resolution of 1024x768 pixels. 

 An OpenGL compatible graphics card. 

Recommended 
 Windows XP operating system. 

 Pentium III 266 processor or higher. 

 128MB of RAM (more for large model and texture sizes). 

 Graphics card capable of displaying 24-bit color. 
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User Interface 
The user interface provides multiple ways to achieve the same goals. It consists of a number of components 
including the menu bar, main toolbar and the Tools Options shelf, the workspace (windows and viewports), 
the Command panel, two palettes, a status bar, and various right-click menus. 

Many of the components can be resized, moved and closed similar to the functionality in most Windows 
applications. For example, you can resize the windows by dragging the windows' edges. 

See the topics referenced below for detailed information on all of the user interface components. 

Interface 

Application title bar—Displays the current file name and path. 

Menu bar—Provides access to the main menu commands. 

Main toolbar—Provides quick access to the tools of some of the most common tasks in Deep UV. 

Tools Options shelf—Displays all the commands that are available for the selected tool. 

Workspace—Consists of file windows that are displayed in multiple viewports. 

Viewports—Displays one 3D viewport, and multiple 2D viewports depending on the selected viewport 
layout. They are used to view and map the current objects and materials. 

Command panel—A floating panel used to access most of the mapping features. 

Tools palette—Provides access to most common tools. 

Layout palette—Used to select the viewport layout. 

Status bar—Displays the progress bar, and information about the selected tool. 

Right-click menus—Sets of commands relating to the standard functionality. 
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